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TLE /QUARTER 1/ GRADE 7 

I. CURRICULUM CONTENT, STANDARDS, AND LESSON COMPETENCIES      

A. Content 
Standards 

The learners demonstrate an understanding of using productivity software 

B. Performance 

Standards  

The learners perform the utilization of productivity tools in a safe and responsible manner 

C. Learning 
Competencies  
and Objectives

  

Learning Competency 
The learners shall be able to create presentations with a master slide, and motion paths. 

Learning Objectives 
At the end of the lesson, the learners shall be able to:  

1. discuss the rules in creating a presentation 

2. create a presentation using master slide, motion path and animation pane 

D. Content Presentation Software 
● rules in creating presentations 

● master slide 

● animation (motion path) 

● animation pane 

E. Integration SDG 4: Quality Education  
SGD 9: Industry, Innovation and Infrastructure 

 

II. LEARNING RESOURCES 

 6. simple rules to help you create effective PowerPoint presentations. (n.d.). https://www.prezent.ai/zenpedia/presentation-rules  

PowerPoint: Slide Master View. (n.d.). GCFGlobal.org. https://edu.gcfglobal.org/en/powerpoint/slide-master-view/1/  

Writtenhouse, S. (2022b, May 3). How to use Motion Path animations in Microsoft PowerPoint. How-To 

Geek. https://www.howtogeek.com/798590/how-to-use-motion-path-animations-in-microsoft-powerpoint/  

 

https://www.prezent.ai/zenpedia/presentation-rules
https://edu.gcfglobal.org/en/powerpoint/slide-master-view/1/
https://www.howtogeek.com/798590/how-to-use-motion-path-animations-in-microsoft-powerpoint/
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Put objects or text on a custom motion path. (n.d.). https://support.microsoft.com/en-us/office/add-a-motion-path-animation-effect-

f3174300-0d24-4671-a1c2-e286b41efba6  

PowerPoint 2016: Animating Text and Objects. (n.d.-b). GCFGlobal.org. https://edu.gcfglobal.org/en/powerpoint2016/animating-text-and-

objects/1/  

 

III. TEACHING AND LEARNING PROCEDURE NOTES TO TEACHERS 

A. Activating Prior 
Knowledge 

 

 

 

DAY 1 
1. Short Review 

Ask the following students? 

1. What have you learned using Word Processing software? 

2. Were these learnings helpful to you? 

3. Do you think you can also apply them using Presentation Software? 

Feedback (Optional) 

 
 

 

B. Establishing 
Lesson Purpose 

1. Lesson Purpose  
Ask the students the following questions: 

1. What can you say with the presentation carrying a good design? 

2. What about this poorly designed presentation? 

3. What could be done to improve the presentation? 

4. Are you familiar with the basic rules in creating a presentation? 

Using presentation software is an effective way of sharing information 
while also keeping the audience hooked and helping them remember what 
was told to them. A good presentation design is crucial in making your 
audience engaged in your presentation. 

  
2. Unlocking Content Vocabulary 

 Master Slide- it has built-in layouts, designs and background graphics. 

 Motion Path- the technique of customizing the animation of an object in 
order to follow a certain path. 

 Animation Pane- command enables a user enables to control and view 
every effect on the active slide. 

Show to the students a poorly 
designed presentation and show 
them also a presentation with a 
good design. Ask them the 
questions. 
 
 
 
 
 
 

https://support.microsoft.com/en-us/office/add-a-motion-path-animation-effect-f3174300-0d24-4671-a1c2-e286b41efba6
https://support.microsoft.com/en-us/office/add-a-motion-path-animation-effect-f3174300-0d24-4671-a1c2-e286b41efba6
https://edu.gcfglobal.org/en/powerpoint2016/animating-text-and-objects/1/
https://edu.gcfglobal.org/en/powerpoint2016/animating-text-and-objects/1/
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C. Developing and 
Deepening 

Understanding 

SUB-TOPIC: 1 - Rules in Creating Presentations 
 

1. Explicitation 

Creating an engaging PowerPoint presentation requires following certain 
rules. In this lesson, we will explore the key principles to help you create 
presentations that will capture the audience's attention.  

● One idea in one slide. This allows the audience to focus on a concept on 
each slide thus, making it easier for them to comprehend and remember. 

● Follow the 5 rules. The 5/5/5 rule is a simple guide to keep things short. 
Observe five words per line, no more than five lines per slide, and of having 
five slides in a row with lots of text. This rule helps keep your audience 

engaged and paying attention. 

● Avoiding slide overload. Limit your elements to six or fewer on each slide. 
This keeps things focused. Also, use short text, add some space (white 
space), and include images or graphics smartly.  

● Mastering slide design. A clear and meaningful heading is a must. It 
helps your audience understand what is coming up. Make sure your 
heading is a short and clear summary of your entire presentation.  

● Effective slide design. Use colors that stand out, keep backgrounds 
simple, and use big fonts. As much as possible, do not use italics, 
underlining, or all caps because they might take away the audience’s focus 
from your main message. 

● Appropriate animation. Avoid using too many animations. Research 

shows that an audience does not like too many movements. Small, simple 
animations can help highlight key points and make your audience 
remember things better. Using too many might distract the audience and 
make your presentation less effective. 

● Utilize visual presentations. Use images and graphs to add interest and 

engagement to your presentation but make sure to observe balance. Avoid 
complex graphics that may distract your audience. When you decide to use 
a graph or chart, make sure to explain what it shows so everyone 
understands the information you are sharing.  

 

2. Worked Example 

It would be good to have a 
healthy discussion here. The 

student’s result of evaluation to 
the two (2) presentations must 
show that the good design 
followed most of the rules while 
the bad design followed only few 
or did not follow any of them. 
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Using the sample presentations that were shown earlier (the good and the bad 
design), determine if the two (2) followed the seven (7) rules. Complete the table 

below by putting a √ mark if the presentation followed a rule otherwise, put X.  

Rules Presentation 1 
(Good) 

Presentation 2 
(Bad) 

One idea in one slide   

Follow the 5 rules   

Avoiding slide overload   

Mastering slide design   

Effective slide design   

Appropriate animation   

Utilize visual presentation   

 
3. Lesson Activity 

Once again, look at the sample presentation (given by your teacher) with the 
“GOOD” design. Discuss how the seven (7) rules in creating a presentation 
were utilized. 

 
DAY 2 
SUB-TOPIC: 2 - Master Slide 

1. 1. Explicitation  

   You might have noticed that some slides have background and other 

elements that cannot be changed and cannot be deleted when in the Normal 

View. What might be the reason why? This is because the slides have built-in 

layouts, designs and background graphics embedded using the Master Slide. If 

you want to edit or change the layout, design and background of all your 

slides, you need to edit the Master Slide.  

  The Master Slide is designed to achieve consistency and professional-looking 

presentation. In PowerPoint presentation, you could use Slide Master View to 

modify all the slides and the slide layouts of your presentation. You can also 

modify the layout of the individual slides.  
Here are some of the most common uses of the Slide Master View. 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
You should prepare a 
presentation file with built-in 
layouts that was created using 
the Slide Master command. This 
presentation will be used by 
students for the practice 
activity. 
 

 
You may give a presentation 
topic that is connected to the 
other Grade 7 subjects. Like for 
example in science they can use 
“Waste Segregation” as their 
topic. 

3.  
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● Modify backgrounds: it customizes the background for all of your slides 

at the same time. When you adjust one of the layouts in the Slide Master 
view, all of the slides with that layout will change. 

● Rearrange placeholders: If you accidentally rearranged the placeholders 
on each slide, you can save time by rearranging them using the Slide 
Master view. 

● Customize text formatting: You could also use the Slide Master view to 
change the text color on all slides at once. 

● Create unique slide layouts: You could use Slide Master view to create 
your own unique layouts. Custom layouts can include your 

own background graphics and placeholders. 
 

● Customizing Slide Layouts 

1. Click the View tab from the 
Ribbon. In the Master 
Views group, click Slide 
Master view.  

2. Locate and select the desired 
layout in the left navigation 
pane. You can hover the 
mouse over each layout to 
see which slides are 
currently using that layout 
in the presentation. 

3. In some layouts, the background graphics may be hidden. To show the 
graphics, uncheck the box next to Hide Background Graphics found 
in the Background group of the Slide Master tab from the Ribbon. 

4. Add, move, or delete any objects as desired.  
5. If you want to change the arrangement of the placeholders, you can 

move, resize, or delete any of them.  
6. When you're finished, click the Close Master View command on 

the Slide Master tab. 
7. All slides using the layout will be updated. 

 

Before introducing today’s 
lesson, you may first have a 

review of the new knowledge 
and skills they have gained from 
the previous lesson.  
 
                                                                                                                                                                                                                                                                                                                                                                                                                                                                       
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 



 

6 
 

● Create New Slide Layouts 

1. Click the View tab from the Ribbon. In the Master Views group, click 

Slide Master view.  

2. Click the Insert Layout command. The new slide layout will appear. 

3. The layout will include title and footer placeholders by default. Click 

the Title and Footers boxes in the Master Layout group to toggle 

these placeholders on and off. 

4. You can now add background graphics, shapes, and pictures to the 

slide layout. You can also move, adjust, and delete the existing 

placeholders.  

5. To add new placeholders, click the down arrow of 

the Insert Placeholder command, then select the desired placeholder 

type.  

6. Click and drag to draw the placeholder on the slide. 

 

 

 

 

 

 

 

 

 

 
 
 
 
2. Worked Example 

Guided Practice: 

1. Open the presentation file that the teacher gave you.  

2. On the slide master, change the Background Style. Choose a background 
from any of the styles shown.  
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3. From the navigation pane, click Title Slide Layout. Try to change the 
location of the placeholders. Try to change the Font and Font Colors.  

4. Apply the rules in creating the presentation in order to have a good match 
of background and element colors.  

5. Click the Title Content Layout. Try to make changes to placeholders, font 
and font colors. Try to add also other elements like shapes. 

6. Apply the seven (7) rules in customizing the layout of your master slide. 
7. Insert a New Slide Layout. Try to add background graphics. 
8. Add also shapes, and pictures to the slide layout by clicking Insert 

Placeholder. 
9. Move, adjust, and delete (if necessary) the existing placeholders. 

10. Show your output to your teacher. 
11. Click Close Master view and save the presentation. Put “Practice” as the 

filename 
 
3.  Lesson Activity. 

See Learning Activity Sheet – Activity No. 1 for the complete details of the 

activity. 

 
DAY 3  

SUB-TOPIC 3 - Motion Path  
 
1. Explicitation  

Have you seen a moving object in a presentation that follows a certain path 

or route? This technique of customizing the animation of an object is called 

Motion Path.  

Animations in Microsoft PowerPoint come in a variety of forms. Effects can 
be applied to shapes, pictures, and text. However, if you want to create your 
own, you can select a motion path animation to move your object wherever you 
like 

PowerPoint's Motion Path animations allow you to add zigzag, loop, spiral, 
or swoosh effects to your objects. You can adjust the points to establish the 
precise path you want your object to go once you have chosen the motion path 
you want to utilize. 

 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
Before introducing the next 
lesson for the day, you may first 
establish the connection 
between the Motion Path and 
the Animation Pane. You may 
ask students the following 
questions: 
1. What motion paths have 

you applied in your slides? 

2. Do you like the order of the 

motion effects in your slide? 

3. What did you do to have a 

preview of the effects of the 

chosen motion path? 

4.  

1.  
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2. Worked Example 

Guided Practice: 

1. Open the “Practice” presentation file 
2. Click an object that you want to animate. 
3. On the Animations tab from the Ribbon, click Add Animation. 
4. Scroll down to Motion Paths, and pick one from the list. 
5. If you would like to draw the path, choose Custom Path from the list. 
6. Draw the path in the slide. To stop drawing a custom path, press Esc. 
7. If you do not like any of the motion paths in the list, click More Motion 

Paths. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
8. Click an animation to see a preview of how the object will move on your slide. 
9. Select the motion path you want then click OK. 
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10. You should see the movement on the 
object in your slide.  

11. Try to change the direction, 
sequence, origin and path.  

12. Click Effect Options from the 
Animations tab and choose from given 
lists.  

13. You should see the effect on the object 
you have selected. 

14. In case you want to remove an 
animation, on the slide, click the 

motion path (dotted line with arrow), 
and then press Delete. 

15. Save the changes you have made to your “Practice” presentation. 
3. Lesson Activity 

See Learning Activity Sheet – Activity No. 2 for the complete details of the 
activity. 
 
 

SUB-TOPIC 4 – Animation Pane 
 

1. Explicitation  

The Animation Pane is an essential part of the Animations tab. This 
command enables you to control and view every effect on the active slide. The 
Animation Pane allows you to easily edit and rearrange effects, which is very 
helpful if you have multiple effects. It also allows you to have an easy and 

quick preview of the animation effects that you have selected. The effect’s 
start option and timing can also be set using the Animation Pane. 

 
2. Worked Example 

Guided Practice: Open the “Practice” presentation file and perform the 

following steps: 

To open the Animation Pane: 
1. From the Animations tab, click the Animation Pane command. 
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2. The Animation Pane will open on the right side of the window. It 
shows all of the effects for the current slide following the order in 

which they will appear.  
 
 
 
 
 
 
 
 
 
 
 
 

To reorder 

effects from the Animation Pane: 
1. On the Animation Pane, click and drag an effect up or down.  

2. You may also use the up and down arrow from the Animation Pane. 

3. Simply select the object with effect and click the up or down arrow. 

To preview effects from the Animation Pane: 
1. From the Animation Pane, click the Play or Play All button. 

2. The effects for the current slide will play.  

To change an effect's start option: 
1. From the Animation Pane, select an effect. A drop-down arrow will appear 

next to the effect. 

2. Click the drop-down arrow and select one of the three start options.  

Start on Click will start the effect when the mouse is clicked, 

Start With Previous will start the effect at the same time as the previous 

effect, and  

Start After Previous will start the effect when the previous effect ends. 
 

To open the Effect Options dialog box: 
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1. From the Animation Pane, select an effect. A drop-down arrow will appear 
next to the effect. 

2. Click the drop-down arrow, then select Effect Options. 
3. The Effect Options dialog box will appear. Click the drop-down menus 

and select the desired settings and enhancements.  
4. You can add a sound to the animation, add an 

effect after the animation is over, or animate text in a different 
sequence. 

To change the effect timing: 
1. From the Effect Options dialog box, select the Timing tab. 

2. From here, you can add a delay before the effect starts, change 

the duration of the effect, and control whether the effect repeats. 

3. Lesson Activity 
See Learning Activity Sheet – Activity No. 3 for the complete details of the 
activity. 
 

 

D. Making 

Generalizations 

DAY 4 
1. Learners’ Takeaways 

In this week’s lessons, I have learned that in order to create effective 
presentations I must do the following: 
_____________________________________________________________________________
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 

 

2. Reflection on Learning 
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IV. EVALUATING LEARNING: FORMATIVE ASSESSMENT AND TEACHER’S REFLECTION NOTES TO TEACHERS 

A. Evaluating 

Learning 

1. Formative Assessment 
Answer the following questions.  
1. What is the function of a Master Slide? 

2. When do you use Motion Paths? 

3. How important is the Animation Pane? 

 

2. Homework (Optional) 

 

B. Teacher’s 
Remarks 

 

Note observations on 
any of the following 
areas: 

Effective Practices Problems Encountered 
The teacher may take note of 
some observations related to 
the effective practices and 
problems encountered after 
utilizing the different strategies, 
materials used, learner 

strategies explored   

materials used   
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learner engagement/ 

interaction 

  engagement and other related 
stuff.  

Teachers may also suggest 
ways to improve the different 
activities explored/ lesson 
exemplar. 

others   

C. Teacher’s 
Reflection  

 

Reflection guide or prompt can be on: 

▪  principles behind the teaching 
What principles and beliefs informed my lesson? 
Why did I teach the lesson the way I did? 
 

▪  students 
What roles did my students play in my lesson? 
What did my students learn? How did they learn? 
 

▪  ways forward 
What could I have done differently? 
What can I explore in the next lesson? 

Teacher’s reflection in every 
lesson conducted/ facilitated is 
essential and necessary to 
improve practice. You may also 
consider this as an input for 
the LAC/Collab sessions. 

 

 

 


